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Operating System and Environment Requirements 
Verify that your system meets the installation requirements described in the 
following tables before you install Oracle8 64-bit.

Hardware Requirements  

Operating System Software Requirements

Hardware Requirements

Architecture HP9000 (determined with the uname -a 
command).

Memory A minimum of 256 MB RAM.

Swap Space Two times the amount of RAM (recommended 
for most systems).

CD-ROM Device A HP-UX 11.0-supported CD-ROM (Oracle uses 
ISO 9660 format CD-ROM disks with Rockridge 
extensions).

OS Software Requirements

Operating System HP-UX 11.0

Operating System Patches 9808 or later extension pack

DART43 C/ANSI C developer’s bundle

PHSS_14581

PHSS_16849

PHSS_17508

PHSS_17691

PHSS_17870

PHSS_18066

PHSS_18072

PHSS_18110

PHCO_13363

PHCO_16039

PHCO_16438

PHCO_20765

PHKL_21180

PHSS_20014
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Note: HP routinely updates, consolidates, and renumbers its 
patches. HP Technical Support always has the latest information 
on its patches. Please contact HP Technical Support to request 
these HP-UX 11.0 patches required for Oracle.
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Required OS

You can determine the version of the OS on your system with the 
command: 

% uname -a

HP-UX 11.0 is the core OS within the HP 9000 package. The getconf 
KERNEL_BITS command should return 64.

Although you can install HP 9000 as 32-bit, you must install it as 64-bit 
(which will also run 32-bit executables). If you try to run 64-bit executables 
on a 32-bit machine, you will see errors of the form: 

./oracle: Exec format error. Wrong Architecture. 

Other Software Requirements

Product Notes
Check the README.doc file in the $ORACLE_HOME/rdbms/doc directory 
before using Oracle8 64-bit. README files for other products on the Oracle8 
64-bit distribution are in the doc directories of their respective products.

The following issues and restrictions might affect the installation or use of 
Oracle8 64-bit on HP 9000.

32-bit/64-bit Database Interoperability

Oracle8 64-bit can access 32-bit 8.0.6 databases on the same platform with 
minimal connection effects by running a SQL script. Please refer to 
READMEMIG.doc in the $ORACLE_HOME/rdbms/doc directory for more 
information.

Product Name Restrictions and Requirements

Pro*COBOL, 8.0.6 and 1.8.28 Requires COBOL/UX Release 8.13.25 or Micro Focus 
COBOL 4.1 rev 10 (32-bit only).

Pro*C/C++, 8.0.6 Requires HP ANSI C Compiler A.11.01.03 for C++, 
HP aC++ Complier A.03.10. 

Pro*FORTRAN, 1.8.28 Requires FORTRAN77 3.0.1 or higher. (32-bit only)

Oracle Parallel Server Requires MC/Service Guard OPS Edition A.11.08 or 
higher, or MC/LockManager Version A.11.03 or 
higher.

All network products require the underlying software and operating system libraries for the 
supported network. Therefore, you must install and run the network software prior to 
installation of the Net8 products. 
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Oracle Visual Information Retrieval

The HP aC++ compiler is a prerequisite for Oracle Visual Information 
Retrieval.

■ install version 3.10 for use with Oracle8 64-bit Release 8.0.6

Oracle Parallel Server Restriction

Because all Oracle databases on a cluster linked in Parallel Server mode 
must match the word size of the Cluster Group Services executable, they 
must all run only a 64-bit executable. Mixing word sizes of parallel server 
executables, even across different databases, will not work in 8.0.x. This 
restriction does not apply to Oracle executables that are not linked in 
Parallel Server modes.

64-bit Files and Directories

In Oracle8 64-bit, the following directories contain 64-bit executables and 
libraries:

■ $ORACLE_HOME/lib64

■ $ORACLE_HOME/rdbms/lib64

The following executables in $ORACLE_HOME are 64-bit; the remainder 
are 32-bit:

■ oracle

■ ogms

■ ogmsctl

■ otrccol

■ otrccref

■ otrcfmt

■ otrcrep

■ proc64

■ sqlldr

Building 64-bit Pro*C Customer Applications

This release supports building 64-bit Pro*C customer applications. You 
must use proc64 instead of proc to precompile programs for 64-bit.

The 64-bit client shared library is: 

$ORACLE_HOME/lib64/libclntsh.sl
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The 64-bit demo makefile is in:

$ORACLE_HOME/precomp/demo/proc/demo_proc.mk

Execute the following command to generate the 64-bit client shared library:

$ORACLE_HOME/bin/genclntsh64

Building 64-bit OCI Customer Applications

This release supports building 64-bit Oracle Call Interface (OCI) customer 
applications. Refer to the $ORACLE_HOME/rdbms/demo/demo_rdbms.mk 
file for more information.

New ORACLE_HOME
You must install Oracle8 64-bit Release 8.0.6 into a new ORACLE_HOME 
directory.

LD_LIBRARY_PATH
Instructions for setting the environment variable LD_LIBRARY_PATH is 
discussed in the platform-specific documentation. Append the following 
path to the ones listed in the documentation: 

$ORACLE_HOME/lib64 

File Systems
The Oracle Server must be able to verify that file writes were made to disk. 
Although you can install Oracle software to them, Oracle databases do not 
support file systems that do not support this verification.

Large SGA Sizes
This 64-bit release supports System Global Area (SGA) sizes larger than 
1.75 GB. Only the amount of available system memory limits the SGA size. 
Therefore, set the HP SHMMAX parameter in your /etc/system file to a 
value high enough to accommodate larger SGA sizes.

Very Large Files
Oracle8 64-bit includes native support for files greater than 2 GB. HP also 
supports large files; however, you should verify that your file system and 
volume manager do not impose file size limits.

Products Not Supported

The following products are not supported by Oracle8 64-bit Release 8.0.6 
for HP 9000 Servers and Workstations:

Products not Supported in Oracle8 64-bit for HP 9000 Servers and 
Workstations

Oracle LU6.2 Protocol Adapter, 8.0.6

Oracle SPX/IPX Protocol Adapter, 8.0.6
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Running Servers and Clients on Different Word Size Systems
Oracle now provides support for 64-bit clients and servers. This support 
eliminates the 2GB addressing limitation of 32-bit releases. Therefore, 
System Global Areas (SGA) and Program Global Areas (PGA) are limited 
only by the physical memory on the computer system. 

64-bit addressing can improve performance by allowing very large buffer 
caches to be configured, thereby reducing I/Os. By eliminating the limit on 
the maximum size of the shared pool, 64-bit addressing can allow more 
users to be logged into Oracle.

The following combinations can run and link successfully:

■ 32-bit applications against a 32-bit Oracle Server

■ 32-bit applications against a 64-bit Oracle Server

■ 64-bit applications against a 32-bit Oracle Server

■ 64-bit applications against a 64-bit Oracle Server

To implement a mixed word-size installation, follow these instructions:

1. Create an ORACLE_HOME for the 32-bit products you are going to install.

2. Create another ORACLE_HOME for the 64-bit products you are going to 
install.

3. Install the 32-bit products in their ORACLE_HOME.

4. Start another Installer Session to install the 64-bit products in their 
ORACLE_HOME.

5. Set the SHLIB_PATH environment variable to point to the appropriate 
32-bit or 64-bit shared library on the client. For example, if you are 
running 32-bit applications, set the SHLIB_PATH environment variable 
to point to the 32-bit shared library.

6. Set the TWO_TASK environment variable to the instance ID of the 32-bit 
or 64-bit target database.

Identix Authentication Adapter, 8.0.6

SecurID Authentication Adapter, 8.0.6

Kerberos Authentication Adapter, 8.0.6

Net8/DCE

Products not Supported in Oracle8 64-bit for HP 9000 Servers and 
Workstations
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Legato Storage Manager

Installing Legato Storage Manager Manually on a 64-Bit System

The usual procedure for installing Legato Storage Manager is to select 
Legato Storage Manager installation when you use the Oracle Installer to 
install your Oracle software. 

The installer asks if you want Legato Storage Manager to be installed. If you 
answer no, you can perform the following steps to install Legato Storage 
Manager manually at a later time.

To install Legato Storage Manager manually, perform the following steps:

1. Be sure no Legato Storage Manager or NetWorker software is installed 
on your system. The Legato Storage Manager installer, lsminst (see 
step 3), attempts to detect existing Legato software. If Legato software 
exists but is not detected, both the existing Legato software and the 
Legato Storage Manager might not function properly. 

2. Go to the /cd_rom_mount_point/stage_tmp/lsm directory on the 
Oracle CD-ROM that contains the Legato Storage Manager software 
including the installer file, lsminst.

cd /cd_rom_mount_point/stage_tmp/lsm

3. As root user, install the Legato Storage Manager software using the 
following lsminst command: 

# ./lsminst /cd_rom_mount_point/stage_tmp/lsm 

When the Software Selection Window appears, perform the following 
steps: 

a. Highlight LSM in the Software Selection Window. 

b. Select Install (analysis) from the Actions menu.

Caution: If you are updating Legato Storage Manager, be sure to 
perform a partial removal of Legato Storage Manager using the 
procedure in "Removing an Existing Legato Storage Manager 
Installation" in Oracle 8 Installation Guide for HP 9000 Servers and 
Workstations.

Be sure you do not remove any existing Legato Storage Manager 
files in the /nsr directory. For more information on updating, refer 
to "Updating Legato Storage Manager" in Oracle 8 Installation Guide 
for HP 9000 Servers and Workstations.
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c. When the Status field in the Install Analysis window is Ready, click 
Logfile to check the log file. Correct any listed problems before 
proceeding.

d. Click OK in the Install Analysis window.

e. Click Yes in the Confirmation dialog box.

f. When the Status field in the Install Window changes to Completed, 
click Logfile to check the log file. Correct any listed problems, then 
rerun the lsminst command.

g. Click Done to exit the Install Window. 

h. Select Exit from the File menu to exit the Software Selection 
Window. 

4. Update the MANPATH and PATH environment variables as required. 
MANPATH must include the directory containing the Legato Storage 
Manager man pages, /opt/networker/man. PATH must include the 
directory where the Legato Storage Manager binaries are installed, 
/opt/networker/bin.

5. For each ORACLE_HOME to be enabled for Legato Storage Manager 
backups, perform the following steps:

Note: If you see an error in the log file stating that one or more 
filesystems in the filesystem table cannot be mounted, verify with 
your site administrator that the filesystems listed in /etc/fstab 
do not need to be mounted. Then, perform the following tasks: 

1. As the root user, restart the Legato Storage Manager 
installation using the lsminst command listed in Step 3 above.

2. In the Options menu of the Software Selection Window, select 
Change Options.

3. In the Options window, deselect "Mount filesystems in 
/etc/fstab or /etc/checklist".

4. Click OK.

5. Perform steps 3a to 3h to complete the Legato Storage 
Manager installation.

Note: If you later install another ORACLE_HOME on your system, 
you must follow these steps to enable Legato Storage Manager 
backups from that ORACLE_HOME.
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a. Log in as the ORACLE_HOME owner.

b. Copy the file liblsm.sl from the stage_tmp/lsm directory on 
the Oracle CD-ROM to the file $ORACLE_
HOME/lib64/liblsm.sl:

cp stage_tmp/lsm/liblsm.sl $ORACLE_HOME/lib64/liblsm.sl 

c. Shut down all Oracle instances that use this ORACLE_HOME.

d. Remove the symbolic link $ORACLE_HOME/lib64/libobk.sl 
and replace it with a symbolic link to the file $ORACLE_
HOME/lib64/liblsm.sl: 

cd $ORACLE_HOME/lib64
rm libobk.sl
ln -s liblsm.sl libobk.sl 

e. Restart all Oracle instances that use this ORACLE_HOME.

Removing Legato Storage Manager Version 5.5 on a 64-Bit System

To remove Legato Storage Manager version 5.5, perform the following 
steps:

1. For each ORACLE_HOME on your system enabled for backups, follow 
these steps to remove the Media Management API of Legato Storage 
Manager:

a. Shut down all Oracle instances that use this ORACLE_HOME.

b. Remove $ORACLE_HOME/lib64/liblsm.sl, and create a 
symbolic link from $ORACLE_HOME/lib64/libobk.sl to 
$ORACLE_HOME/lib64/libdsbtsh8.sl: 

cd $ORACLE_HOME/lib64
rm libobk.sl 
rm liblsm.sl 
ln -s libdsbtsh8.sl libobk.sl 

c. Restart all Oracle instances that use this ORACLE_HOME. 

2. As root user, stop the Legato Storage Manager daemons using the 
nsr_shutdown command: 

# nsr_shutdown 

Note: You cannot remove Legato Storage Manager using the 
Oracle Installer. You must use the steps described in this section to 
remove Legato Storage Manager version 5.5.
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3. As root user, remove the Legato Storage Manager software using the 
swremove command: 

# swremove 

When the Software Selection Window appears, follow these steps: 

a. Highlight LSM in the Software Selection Window.

b. Select Remove (analysis) from the Actions menu.

c. When the Status field in the Remove Analysis window is Ready, 
click Logfile to check the log file. Correct any listed problems before 
proceeding. 

d. Click OK in the Remove Analysis window. 

e. Click Yes in the Confirmation dialog box.

f. When the Status field in the Remove Window changes to 
Completed, click Logfile to check the log file. Correct any listed 
problems, then restart the removal from step 1 of this procedure.

g. Click Done to exit the Remove Window.

h. Select Exit from the File menu to exit the Software Selection 
Window.

i. Verify that the /opt/networker directory has been removed. If 
required, remove the /opt/networker directory manually. 

4. To remove the Legato Storage Manger index and resource configuration 
files, remove the /nsr directory by running the following command as 
root user:

# rm -rf /nsr/* /nsr
If you remove the /nsr directory containing the index and 
configuration information, you will not be able to restore from the 
Legato Storage Manager backups. If you later install Legato Storage 
Manger or another Legato product, you will need to rebuild the 
configuration.

Note: The swremove command does not remove the /nsr 
directory containing Legato Storage Manager client and media 
index files and resource configuration files. 
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Other Information Resources
In addition to this release note and the Oracle documentation, which you 
received on CD or in printed form, there are several other valuable sources 
of technical information available to you:

■ Platform-Specific Documentation

■ Online Support

■ Product README Files

Platform-Specific Documentation

The Oracle8 Administrator’s Reference for HP 9000 Servers and Workstations 
and the Oracle8 Installation Guide for HP 9000 Servers and Workstations are 
available online and on the Oracle8 64-bit software CD-ROM. Instructions 
for accessing the documents are on the CD Insert.

Online Support

For current information on subjects such as product certifications, see the 
following websites:

■ http://support.oracle.com

■ http://technet.oracle.com

Product README Files

Most Oracle products include a README file in the software distribution. 
The most common location for these files is in the 
$ORACLE_HOME/product/doc/ directory, for example: 

$ORACLE_HOME/network/doc/README.Net8.

README files include information such as known restrictions, bugs fixed in 
this release, and new product functionality.
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